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Installation Instructions for 
TCS-1 Timing Control System 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. NOT LEGAL FOR SALE 

OR USE IN CALIFORNIA OR ON ANY POLLUTION CONTROLLED VEHICLES. 

  

OVERVIEW 
The TCS-1 is a versatile timing control system 

for race engines. It is a direct replacement for MSD 
P/N 8980 Timing Computer with many additional 
features.  

 Preprogrammed with 20° advance curve between 
1,000 and 3,000 RPM for V8 engines same as MSD 
P/N 8980.  

 Magnetic pickup (distributor or crank trigger) and 
module trigger inputs.  

 Module trigger output drives all CD systems including 
MSD 6 and MSD 7 series. 

 USB interface and PC Link software allows 
programming advance features ranging from a 
simple RPM based advance curve to a 3D timing 
map with boost proportional retard (requires optional 
MAP sensor). 

 Two general purpose input and one general purpose 
input/output terminals. Inputs can be programmed for 
multiple retard functions including driver adjustable 
retard. Output can be programmed for RPM window 
switch function. 

 GPI inputs preprogrammed for 2°, 3°, and 4° retard 
functions (can be combined for a total 2-9°).       

 Heavy duty industrial grade clamping terminal blocks 
allow easy and reliable hookup without soldering or 
crimping.                                      

 Compact size: 3.3”L x 2.4”W x 1.1”H.       

 USB interface to laptop PC (not required for basic 
operation). Powerful Windows software for 
programming controller functions including use on 4 
and 6 cylinder engines. 

 

ADDITIONAL REQUIRED PARTS 
For a driver adjustable timing retard or boost 

proportional retard, you will require the optional RTD-1 
retard control P/N 102005. To connect a Delphi MAP 
sensor, you will have to fabricate a wiring harness with 
the appropriate mating connector or use our MAP 
sensor harness kit P/N 102006.  

The parts bag supplied with the TCS-1 includes 
a magnetic pickup harness with AMP connector that 
mates with industry standard  magnetic pickup 
distributors and crank triggers. To complete the 
installation, you may require additional wire and crimp 
terminals. The Appendix includes a list of 
recommended parts and suppliers. 

Figure 1 – TCS-1 System  
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WIRING OVERVIEW 

Signal Connections (in order from left to right on terminal blocks) 

+12V POWER  Connects to ignition switch. The TCS-1 is compatible with nominal 12-16 volt 
electrical systems.   

MAG+ IN Connects to magnetic pickup distributor or crank trigger. If the magnetic 
trigger inputs are used, the module trigger input (MOD TRIG IN) must be left 
open.  

MAG- IN Connects to magnetic pickup distributor or crank trigger. If the magnetic 
trigger inputs are used, the module trigger input (MOD TRIG IN) must be left 
open. 

MOD TRIG IN Connects to trigger output from a distributor with internal amplifier or engine 
control module. If the module trigger input is used, the magnetic trigger inputs 
(MAG+ IN and MAG- IN) must be left open. 

MOD TRIG OUT Connects to module/points trigger type input on a capacitive discharge 
ignition (MSD white wire or PTS terminal). 

GPI1 General purpose input 1. Preprogrammed as a 2° retard input. Also used as 
input for RTD-1 retard command signal. 

GPI2 General purpose input 2. Preprogrammed as a 3° retard input.  

GPIO3 General purpose input/output 3. Preprogrammed as a 3° retard input. 

MAP POWER 5V power. Connects to MAP sensor and/or RTD-1 power. 

MAP SIGNAL  Connects to 0-5V MAP sensor signal 

MAP GROUND Connects to MAP sensor and/or RTD-1 ground 

NOT USED  

NOT USED  

GROUND Connects to chassis ground.    

http://www.daytona-twintec.com/
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Figure 2 – Basic Magnetic Trigger Hookup 

 

http://www.daytona-twintec.com/


 

 
Daytona Sensors LLC, 933 Beville Road, Suite 101-I, S. Daytona, FL 32119                                               TCS-1 
(386) 322-7390   www.daytona-sensors.com  8/2021 

 Page 4 

Figure 3 – Basic Module Trigger Hookup 
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INSTALLATION 
1. Turn off the ignition switch and disconnect the 

battery ground cable before proceeding. 

2. Select a convenient mounting location for the  
TCS-1. The unit is not sealed and must be 
mounted in a dry location away from sources of 
heat. We recommend under dash mounting. The 
unit is not intended for under hood mounting. You 
can secure the TCS-1 with two sheet metal screws 
or Velcro tape strips. Orient the unit so that you will 
have easy access to the terminal blocks and USB 
port.   

3. Refer to Figures 2 or 3 for basic hookup. All signal 
connections can be made with 18-20 AWG wire. 

4. Working with clamping terminal blocks. All 
connections to the TCS-1 terminal blocks must be 
clearly identified either by means of distinct wire 
colors or the use of wire labels. If you use distinct 
wires colors, mark up the appropriate figures on 
this instruction sheet for future reference. Refer to 
the Appendix for recommended wire labels. Wire 
should be stripped back 3/16-1/4 inch. No bare 
wire should be visible outside the terminal block. 
Use a miniature Phillips or flat screwdriver to 
tighten the screws.   

5. Ground connection. Keep the ground connection 
as short as possible. The ground connection must 
go to a chassis ground stud (you can usually find 
one under the dash).  

6. +12V Power. Connect to the ignition switch (or red 
wire on MSD units). Note that the TCS-1 is 
compatible with nominal 12-16 volt electrical 
systems. 

7. Trigger input signal connections. The 
violet/green magnetic pickup cable is supplied with 
an AMP connector that will mate with common 
MSD magnetic pickup distributors and crank trigger 
systems. For other magnetic pickups, cut off the 

connector and refer to the color code table below. 
For module triggered applications from distributors 
with internal amplifiers or engine control modules, 
the TCS-1 requires a 0-12V square wave signal 
and fires on the rising edge. The module trigger 
input is tolerant of high voltage pulses and has an 
internal 150 ohm pull-up resistor to +12V. 

 

Magnetic Trigger Color Codes 

System Mag- Mag+ 

Accel/Chrysler 
Distributor 

Black Orange/White 

Accel Crank 
Trigger 

Black White 

Moroso Crank 
Trigger 

White Black 

MSD Crank 
Trigger 

Green/Black Violet/Orange 

MSD/Ford 
Distributor 

Violet Orange 

GM Distributor Green White 

8. Module trigger output. Connect to the white wire 
or terminal labeled PTS on MSD and other 
capacitive discharge ignition systems. The module 
trigger output is a 0-12V square wave signal and 
fires on the rising edge. It does not include an 
internal pull-up resistor as this is normally part of 
the input circuitry of capacitive discharge ignitions.  

9. Application specific signal connections. Refer 
to the following sections and Figures 4-7. 

10.  Completing the installation. Reconnect the 
battery. Start engine and check timing. If timing 
above 3,000 RPM has changed significantly, 
MAG+ and MAG- may be reversed.

http://www.daytona-twintec.com/
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Figure 4 – Retard Switch Hookup  

 

 

Figure 5 – MAP Sensor Hookup 
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Figure 6 – RTD-1 Retard Control Hookup 

 

 

Figure 7 – RPM Window Switch Hookup 
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Retard Switch Hookup 

Refer to Figure 4. The general purpose 
input/output terminals are preprogrammed for 2°, 3°, 
and 4° retard functions. Retard is active when +12V is 
applied, either by means of a switch or some other 
external circuit. Individual switches can be connected 
to each terminal or several terminals can be connected 
together. For example, the TCS-1 will retard timing 9° if 
all three terminals are connected to a single switch. 
The PC Link TCS software can be used to 
independently program each terminal for 0-10° retard.    

MAP Sensor Hookup 
A manifold absolute pressure (MAP) sensor is 

required for all applications that use a 3D timing table 
uploaded with the PC Link TCS software.  

The optional MAP sensor harness includes 
mating connector shells for Delphi 1 bar, 2 bar, and 3 
bar MAP sensors (refer to the Appendix for 
recommended MAP sensor part numbers). Select the 
connector shell with the appropriate indexing features 
for your MAP sensor. Connect the ground, MAP signal, 
and +5V power wires as shown in Figure 5.  

 

RTD-1 Retard Control Hookup 

The RTD-1 retard control is required for 0-10° 
driver adjustable retard (GPI1 analog retard mode - 
refer to page 13 for details).  

The RTD-1 unit is not waterproof and is intended 
for under dash mounting only. Connect the ground, 
retard command, and +5V power wires as shown in 
Figure 6.  

RPM Window Switch Hookup  

The PC Link TCS software can be used to program the 
GPIO3 terminal as an RPM window switch output. 
When active, the output can sink 1 amp current from a 
load returned to +12V (the output looks like a switch 
connected to ground). Figure 7 shows typical hookup 
using a relay to drive a higher current load. You can 
connect an optional arming switch as shown. For direct 
battery power connections, you should also install a 
fuse. Refer to the Appendix for recommended relays 
and fuses.  

BASIC OPERATION 
The TCS-1 unit is factory preprogrammed with 

the timing curve shown in Figure 8.  The general 
purpose input/output terminals are preprogrammed for 
2°, 3°, and 4° retard functions.  

Figure 8 – TCS-1 Preprogrammed Timing Curve 
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PC LINK TCS SOFTWARE 
OVERVIEW 

Use of the software is optional and not required 
for basic operation of the TCS-1 system. If you are not 
planning on using the software, you can skip the rest of 
the material in this instruction manual.  

PC Link TCS software runs under Microsoft 
Windows XP/Vista/7/8. This software allows the user to 
program TCS-1 units with custom timing advance 
tables and to configure the function of the general 
purpose input/output (GPIO) terminals and other 
engine parameters. The TCS-1 connects  to your PC 
by means of a USB interface. A USB cable is supplied 
with the unit. The PC must have a free USB port. If you 
have an older PC without USB capability, you cannot 
use the unit.  

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the unit’s USB interface to use a 
different COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup.  

PC communications is possible when power is 
turned on and the engine has not yet been started. 
Note that no damage or data corruption occurs if the 
engine is inadvertently started while the USB interface 
is connected. 

After PC Link TCS is launched, the main screen 
appears blank. You have three options for obtaining 
setup data for editing. You can open a previously 
saved setup file by using the Open Table command on 
the File menu. You can create a new setup file by 
using (as applicable) the Edit Module Parameters and 
Edit GPIO Parameters commands from the Edit menu 
and the New Timing Table command on the File menu. 
You can also download data from an attached TCS-1 
unit by using the Download From EEPROM command 
on the Communications menu. 

Note that setup files use a .dat extension. You 
should create a separate folder to store these files.   

If you have enabled a 2D or 3D timing table 
under module parameters, you can use the Edit Timing 
Table command from the Edit menu. You can edit the 
timing table data by clicking on and dragging individual 
points on the chart display or you can directly edit 
numeric data on the spreadsheet grid.  

Once the appropriate parameters and timing 
table data have been entered, you can print the data 
using the Print Parameters and Timing Table 

command on the Print Menu. You can save the edited 
setup file by using the Save Table command on the 
File menu.  

You can upload the setup data to an attached 
TCS-1 unit by using the Upload to EEPROM command 
on the Communications menu.   

A setup file (TCS1_Sample.dat) is included in 
the program folder. 

PC REQUIREMENTS 
The TCS-1 connects to your PC by means of a 

USB interface. The PC must have a free USB port. If 
you have an older PC without USB capability, you 
cannot use the software. 

We recommend a laptop PC with Pentium 
processor and super VGA display (SVGA with 1024 x 
768 pixel resolution) running Windows XP/Vista/7/8. 
Data chart display is graphics intensive and a high 
speed Pentium processor is recommended. 
Processors slower than 300 MHz will exhibit sluggish 
program loading and response.  

PC Link TCS software includes print commands 
to print parameters and timing tables. The program has 
been tested with Hewlett-Packard laser and inkjet 
printers and Epson inkjet printers. We recommend 
using a color inkjet printer. 

USB INSTALLATION 
If you have already installed the USB interface 

driver for the TCS-1, you can skip this step. 

The USB interface for the TCS-1 is based on the 
FTDI FT232R chip and drivers that allow the unit to 
emulate a standard Windows RS-232 COM port. 
Updated Windows drivers, installation instructions and 
troubleshooting tips are available on the FTDI website 
at www.ftdichip.com.  Additional information and 
troubleshooting tips can be found on the PC Link Tech 
FAQ on our website.  

A new USB driver that simplifies the installation 
process is available. This installs as an executable file, 
similar to other Windows programs. The Windows 
Found New Hardware Wizard will then detect the USB 
device when it is first connected and automatically 
install the correct driver without the user having to 
browse out. 

Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's PC Link Tech FAQ for details. 

http://www.daytona-twintec.com/
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1. Make sure the unit is not connected to your PC.   

2. From the Website download the Software under 
the Tech Center tab in the software library folder. 
Scroll down and click on the USB Driver link. When 
the File Download dialog box appears, click on 
"Run this program from its current location." Ignore 
any security warnings and click on Yes to continue.  

3. After installation of the driver is complete, connect 
the unit to the PC with the supplied USB cable. 
The Windows Found New Hardware Wizard will 
appear and complete installation of the USB driver.   

COM Port Configuration 

After completing the installation steps outlined 
above, you must configure the new COM port using 
Device Manager.  

1. Windows XP: click Start, Settings, Control Panel, 
System, Hardware, and then Device Manager. 
Windows Vista: click Start, Control Panel, System 
and Maintenance, and then Device Manager. 
Windows 7: Click Start, Control Panel, System 
and Security, and then Device Manager. For more 
information, visit www.pcsupport.about.com. 

2. Scroll down to Ports (COM and LPT). The new unit 
will as appear as USB Serial Port. Click on this 
new port. Click on the Port Settings tab. 

3. Click on Advanced. In most cases the wizard will 
have installed your new unit as COM5. Note the 
COM port number assigned for your system. For 
optimum performance, you should also change the 
BM Options Latency Timer to 2 msec as shown in 
the Figure. 

4. Once you have configured a COM port number for 
your new unit, make sure that you use this same 
COM port selection in the software by using the 
Port Setup command from the Communications 
menu. 

 

 

 

 

 

 

 

Figure 9 – COM Port Configuration 

 

SOFTWARE INSTALLATION 
The software is supplied in the form of a 

compressed file downloaded from our website. The 
installation process uses InstallShield. This industry 
standard installer is based the new Microsoft Windows 
Installer service that greatly reduces potential problems 
such as version conflicts and allows for application 
self-repair.  

Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's Tech FAQ for details. 

Use the Windows Explorer to launch the 
PC_Link_TCS setup.exe file downloaded from our 
website. InstallShield will install the software in an 
appropriate folder under Program Files. 

Once InstallShield has completed the 
installation, PC Link TCS will appear on the Windows 
Start Menu. You can then launch it just as you would 
any other Windows program.  

PC Link TCS software requires the Monospace 
821 BT fixed pitch printer font in order to properly align 
columns when printing. The Monospace 821 BT font is 
included in the distribution media and automatically 
copied to your Windows Fonts folder during 
installation. A backup copy is also placed in the 
program folder. If you accidentally delete this font, use 
the Install New Font command from the Fonts folder 
File menu. The filename associated with Monospace 
821 BT is monos.ttf. 

http://www.daytona-twintec.com/
http://www.pcsupport.about.com/
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DOWNLOADING DATA FROM 
EEPROM  

Connect the USB cable and turn on power to the 
TCS-1. Do not start the engine. 

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the USB interface to use a different 
COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup.  

Download data by using the Download From 
EEPROM command on the Communications menu.  

If the download process is successful, the 
module parameters are displayed. You can then edit 
setup data as explained in subsequent sections.  

TCS-1 units are shipped from the factory with 
default parameters and timing tables loaded into 

EEPROM memory. If you have never uploaded any 
custom setup file to EEPROM memory, these defaults 
are what you will see.   

MODULE PARAMETERS  
Module parameters are displayed in a dialog box 

by using the Edit Module Parameters command on the 
Edit menu. Module parameters control the overall 
operation of the TCS-1 unit.  

When PC Link TCS is first started, default 
module parameters are loaded. Module parameters 
are updated whenever you download data from a TCS-
1 unit or open a setup file. Module parameters are 
saved along with the GPIO parameters and timing 
table data when you save a setup file. Always check 
the module parameters before uploading data to 
the TCS-1.   

Figure 10 – Module Parameters 

 
General Options 

4, 6, or 8 Cylinder Engine - sets the engine type. 8 
cylinder engine is the default. You must select the 
correct engine type for proper scaling of RPM limit and 
timing control functions.  

 

Automatic Start Retard  - selecting this option 
enables the automatic start retard and the start retard 
slider is displayed. You can set a start retard value 
from zero to 10 degrees. The automatic start retard  is 
active for 10 engine revolutions after engine start while 
the engine is running below 450 RPM.  
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Disable Timing Functions - all timing functions 
including the automatic start retard and any timing 
table are disabled. 

Cranking Pulses - the slider sets the number of trigger 
pulses (events) before the TCS-1 fires the first spark. 
For a V8 engine, there are 4 trigger pulses per 
revolution. To prevent spurious firing when the ignition 
key is turned on, you should always use a value of 2 or 
higher.   

Retard Comp - the slider allows fine tuning the timing 
to eliminate the effects of spark firing delay and the 
intrinsic delay of some magnetic pickup systems. A 
typical value is 1.5 degrees. Check the timing with a 
timing light. If a noticeable retard is observed between 
2,000 RPM and the upper RPM range of the engine, 
use a higher value for retard compensation. 

Timing Table Options 

Disable Timing Table - no timing table is active. 

2D Timing Table - enables a 2D timing table with 
timing based on engine RPM. 

3D Timing Table - enables a 3D timing table with 
timing based on engine RPM and manifold absolute 
pressure (MAP). The MAP sensor option box appears. 
You can select a 1 bar, 2 bar, or 3 bar MAP sensor. To 
use the 3D timing table, a MAP sensor must be 
connected. Refer to Figure 5 and page 8 for details.  

Trigger Timing 

The TCS-1 and similar competitive products 
require a trigger signal (magnetic pickup or 12V 
module output) with a single pulse per firing event. The 
rising edge of the trigger pulse is the most advanced 

timing (earliest spark firing) that the unit can generate. 
All timing curves and other timing functions are based 
on delaying the spark firing referenced to the trigger 
pulse. Refer to page 17 for additional information on 
trigger timing. 

Set the Trig (Trigger) Timing slider value to 
correspond to the actual advanced timing point 
(degrees BTDC) of your trigger signal. The trigger 
timing value represents the most advanced timing that 
the TCS-1 can generate. The default value is 30 
degrees BTDC, but you must enter the actual value for 
your engine (or adjust your trigger system so that it 
generates a trigger signal at 30 degrees BTDC).  

Timing table data “tracks” the trigger timing 
value. The table values always represent the actual 
engine timing that will result if the trigger system 
generates a pulse corresponding to the trigger timing 
value.  

General Purpose Input/Output 
Parameters 

General purpose input/output (GPIO) 
parameters are displayed in a dialog box by using the 
Edit GPIO Parameters command on the Edit menu. 
GPIO parameters control the function of the GPI1, 
GPI2, and GPIO3 terminals on the TCS-1 unit.   

When PC Link TCS is first started, default GPIO 
parameters are loaded. GPIO parameters are updated 
whenever you download data from a TCS-1 unit or 
open a setup file. GPIO parameters are saved along 
with the module parameters and timing table data 
when you save a setup file. Always check the GPIO 
parameters before uploading data to the TCS-1.  

Figure 11 – GPIO Parameters 
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General Purpose Input 1 (GPI1) 

GPI1 has three modes: 

Off - the GPI1 input is disabled.   

Analog Retard - refer to the TCS-1 instructions for 
details. The optional RTD-1 retard control is connected 
to GPI1, the +5V reference supply, and signal ground 
on the TCS-1. The RTD-1 can be used to dial in a zero 
to 10 degree retard. Zero volts on GPI1 corresponds to 
zero retard and +5V corresponds to 10 degrees retard. 
This mode can be used as a driver adjustable timing 
function. 

Digital Retard - you can enter a retard value from zero 
to 10 degrees. The retard will be active whenever a 
+12V signal level is detected on GPI1. 

General Purpose Input 2 (GPI2) 

GPI2 has two modes: 

Off - the GPI2 input is disabled.   

Digital Retard - you can enter a retard value from zero 
to 10 degrees. The retard will be active whenever a 
+12V signal level is detected on GPI2.  

General Purpose Input/Output 3 (GPIO3) 

When configured as an output, GPIO3 can 
switch a 1 amp load to ground. A relay must be used to 
control larger loads, such as solenoid valves. GPIO3 
has three modes: 

Off - the GPIO3 function is disabled. 

Digital Retard - you can enter a retard value from zero 
to 10 degrees. The retard will be active whenever a 
+12V signal level is detected on GPIO3.  

RPM Window Switch - the GPIO3 output will be active 
(switched to ground) whenever engine RPM is within 
the minimum and maximum values.  

CREATING A NEW TIMING TABLE 
If you are creating a new setup file, you must 

first select the 2D or 3D timing table option under 
module parameters as explained in the Module 
Parameters section. You can then use the New Timing 
Table command on the File menu. A dialog box 
appears as shown in Figure 12 or 13 depending on the 
type of timing table you selected. 

 

 

 

Figure 12 – New 2D Timing Table Dialog 

 

New 2D Timing Table 

For a new 2D timing table, you can enter the 
trigger timing, start and final RPM, and start and final 
advance. A new value of trigger timing overrides and 
updates whatever value you may have previously 
entered under module parameters. Set the trigger 
timing value to correspond to the actual advanced 
timing point (degrees BTDC) of your trigger signal. The 
trigger timing value represents the most advanced 
timing that the TCS-1 can generate. The default value 
is 30 degrees BTDC, but you must enter the actual 
value for your engine (or adjust your trigger system so 
that it generates a trigger signal at 30 degrees BTDC). 
Trigger timing is shown on the graph as a straight blue 
line. The actual timing advance curve is shown in red. 
Since trigger timing represents the most advanced 
timing, the red timing curve can never go above the 
blue trigger timing line. The total timing range of the 
TCS-1 is limited to 22 degrees to prevent possible 
crossfiring into the next cylinder. For example, if you 
set trigger timing to 30 degrees, the actual advance 
range is 8.0 to 30 degrees. The program will not allow 
you to enter values outside this range. 

Each time you click on Update, the 
corresponding timing advance table is displayed. You 
will find the New Timing Table command useful for 
generating a timing advance table that will serve as a 
starting point for further edits. When you are ready to 
proceed with editing, click on OK. 

http://www.daytona-twintec.com/
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Figure 13 – New 3D Timing Table Dialog 

 

New 3D Timing Table 

For a new 3D timing table, you can enter the 
trigger timing and a base timing value. The base timing 
value is used to generate a flat timing table. A new 
value of trigger timing overrides and updates whatever 
value you may have previously entered under module 
parameters. Set the trigger timing slider to correspond 
to the actual advanced timing point (degrees BTDC) of 
your trigger signal. The trigger timing value represents 
the most advanced timing that the TCS-1 can 
generate. The default value is 30 degrees BTDC, but 
you must enter the actual value for your engine (or 
adjust your trigger system so that it generates a trigger 
signal at 30 degrees BTDC). Since trigger timing 
represents the most advanced timing, the 3D timing 
table values can never exceed the trigger timing. The 
total timing range of the TCS-1 is limited to 22 degrees 
to prevent possible crossfiring into the next cylinder. 
For example, if you set trigger timing to 30 degrees, 
the actual advance range is 8.0 to 30 degrees. The 
program will not allow you to enter values outside this 
range. 

Each time you click on Update, the 
corresponding timing advance table is displayed. You 
will find the New Timing Table command useful for 
generating a timing advance table that will serve as a 
starting point for further edits. When you are ready to 
proceed with editing, click on OK. 

EDITING TIMING TABLE DATA 
Once you have timing advance table data, you 

can edit the data by clicking on and dragging individual 
points on the chart display or you can directly edit 
numeric data on the spreadsheet grid.  

2D Timing Table 

The table consists of 21 columns corresponding 
to 500 RPM increments from zero to 10,000 RPM. The 
10,000 RPM timing value is used at all higher RPM 
levels.  

The trigger timing value represents the most 
advanced timing that the TCS-1 can generate. The 
default value is 30 degrees BTDC, but you must use 
the actual value for your engine (or adjust your trigger 
system so that it generates a trigger signal at 30 
degrees BTDC). If you need to change the trigger 
timing value, go back to module parameters. Trigger 
timing is shown on the graph as a straight blue line. 
The actual timing advance curve is shown in red. Since 
trigger timing represents the most advanced timing, the 
red timing curve can never go above the blue trigger 
timing line. The total timing range of the TCS-1 is 
limited to 22 degrees to prevent possible crossfiring 
into the next cylinder. For example, if you set trigger 
timing to 30 degrees, the actual advance range is 8.0 
to 30 degrees. The program will not allow you to enter 
values outside this range. 

There is a slight signal delay within the TCS-1 
and associated capacitive discharge ignition system. 
This affects the maximum advance that can be 
generated at high RPM. You should leave about 1 
degree headroom between the maximum advance 
value on your table and the reference (trigger) timing 
value. For example, if your reference timing is 30 
degrees, you should not use timing table values 
exceeding 29 degrees above 3,000 RPM. 

PC Link TCS is intended to be an open system 
and uses the Component One Chart 7.0 2D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link TCS. 
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Figure 14 – 2D Timing Table 

3D Timing Table 

The 3D timing advance table consists of 21 
columns corresponding to 500 RPM increments from 
zero to 10,000 RPM and 8 manifold pressure (MAP) 
rows. The MAP range depends on the type of MAP 
sensor selected under module parameters. The timing 
value at 10,000 RPM is used at all higher RPM levels 
and the timing value in the lowest MAP row is used at 
all lower MAP levels. Note that 30 In-Hg corresponds 
to atmospheric pressure (zero boost). Normally 
aspirated engines will not exceed 30 In-Hg and not all 
supercharged engines will reach the maximum MAP 
level for 2 bar or 3 bar MAP sensors. The trigger timing 
value represents the most advanced timing that the 
TCS-1 can generate. The default value is 30 degrees 
BTDC, but you must use the actual value for your 
engine (or adjust your trigger system so that it 
generates a trigger signal at 30 degrees BTDC). If you 

need to change the trigger timing value, go back to 
module parameters. Since trigger timing represents the 
most advanced timing, the 3D timing table values can 
never go exceed the trigger timing. The total timing 
range of the TCS-1 is limited to 22 degrees to prevent 
possible crossfiring into the next cylinder. For example, 
if you set trigger timing to 30 degrees, the actual 
advance range is 8.0 to 30 degrees. The program will 
not allow you to enter values outside this range. 

There is a slight signal delay within the TCS-1 
unit. This affects the maximum advance that can be 
generated at high RPM. You should leave about 1 
degree headroom between the maximum advance 
value on your table and the reference (trigger) timing 
value. For example, if your reference timing is 30 
degrees, you should not use timing table values 
exceeding 29 degrees above 3,000 RPM.    
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Figure 15 – 3D Timing Table 

 

You can rotate the 3D chart display for a better 
view of a particular region by dragging the mouse while 
holding both mouse buttons down. PC Link TCS is 
intended to be an open system and uses the 
Component One Chart 7.0 3D charting control. The 
adventurous user can experiment with the chart 
property pages by right clicking on the chart. Almost 
any chart property can be changed. Click on the Help 
button for more information. If you corrupt the chart, 
exit and restart PC Link TCS.  

Editing Spreadsheet Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
the left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command.   

 

 

Figure 16 – Modify Command 

 

Data Export and Import by Means of Copy 
and Paste 

You might want to export or import table data to 
or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link TCS program. In the PC Link 
TCS program, you can select a range of cells with the 
mouse and right click to bring up a copy and paste 
menu. When you paste data into the PC Link TCS 
program, the data is automatically checked and any 
out-of-range data corrected. 

http://www.daytona-twintec.com/
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UPLOADING DATA TO EEPROM 
Refer to the Downloading Data from EEPROM 

section on page 11 for details about USB cable hookup 
and COM port setup. Before uploading, make sure the 
parameters and timing tables are correct.  

Upload data by using the Upload To EEPROM 
command on the Communications menu. A status 
message is displayed when the upload process has 
been successfully completed. 

TRIGGER TIMING 
CONSIDERATIONS 

Refer to Figure 20. The trigger timing value set 
under module parameters must correspond to the 
actual timing point (degrees BTDC) of your trigger 
signal. The trigger signal can come from a magnetic 
pickup crankshaft position sensor, magnetic distributor 
pickup, or 12V module trigger signal from another 
system such as an electronic engine control module 
(ECM). The trigger timing value represents the most 
advanced timing that the TCS-1 can generate. The 
default value is 30 degrees BTDC, but you must enter 
the actual value for your engine (or adjust your trigger 
system so that it generates a trigger signal at 30 
degrees BTDC). Since trigger timing represents the 
most advanced timing, the timing table values can 
never exceed the trigger timing. The total timing range 
of the TCS-1 is limited to 22 degrees to prevent 
possible cross firing into the next cylinder. For 
example, if you set trigger timing to 30 degrees, the 
actual advance range is 8.0 to 30 degrees (shaded 
area in Figure 20). 

Figure 17 – Trigger Timing 

 

 

Magnetic Pickup Crankshaft Position 
(CKP) Sensor 

You can accurately establish the position of the 
CKP sensor by temporarily disabling multi-spark and 
any timing table in module parameters (remember to 
upload to TCS-1). Use a timing light to check the timing 
and adjust the position of the CKP sensor as required 
so that your observed engine timing is the same as the 
trigger timing value. For best accuracy, we suggest 
that you set the timing at 1,500-2,000 RPM. While you 
are conducting this test, you should also check the 
distributor phasing. Use a spare distributor cap and drill 
or mill a large hole on the top or side so that you can 
observe the rotor tip position at cylinder 1 with the 
timing light. If you are using a dial-back timing light, set 
the dial-back to zero while observing rotor tip position. 
The leading edge of the rotor should just touch the cap 
terminal.  

Magnetic Pickup Distributor without 
Advance Mechanism 

You can accurately establish the position of the 
distributor by temporarily disabling multi-spark and any 
timing table in module parameters (remember to 
upload to TCS-1). Use a timing light to check the timing 
and adjust the position of the distributor as required so 
that your observed engine timing is the same as the 
trigger timing value. For best accuracy, we suggest 
that you set the timing at 1,500-2,000 RPM.  

Magnetic Pickup Distributor with Advance 
Mechanism 

In this case, you will not be using a timing table, 
but you might still want to use the retard features and 
data logging. Set the trigger timing value to correspond 
to the maximum distributor advance at high RPM.  

Module Trigger from an ECM  

In this case, you will not be using a timing table, 
but you might still want to use the retard features and 
data logging. Set the trigger timing value to correspond 
to the maximum advance generated by the ECM at 
high RPM. 

http://www.daytona-twintec.com/
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APPENDIX – RECOMMENDED 
PARTS AND SUPPLIERS 

MAP SENSORS 
To connect a Delphi MAP sensor for boost 

timing retard mode or for implementing a 3D timing 
table, you will have to fabricate a wiring harness with 
the appropriate mating connector or use our MAP 
sensor harness kit P/N 102006. Recommended Delphi 
MAP sensors, and equivalent aftermarket parts are 
listed in the table below. Note that Wells is stocked by 
Autozone (www.autozone.com) and SMP (Standard 
Motor Products) is stocked by RockAuto 
(www.rockauto.com). 

Range Delphi P/N Aftermarket P/Ns 

1 bar 
(normally 
aspirated 
engines)  

12219927, 
16254719, 
16175339, 
12247561 

Wells SU105 

SMP AS165 

2 bar (0-15 
psi boost) 

16009886 
Wells SU129 

SMP AS4 

3 bar (0-30 
psi boost) 

12223861 
Wells SU504 

SMP AS210 

WIRE 

Wire supplied with most automotive accessories 
is usually un-tinned copper with a low number of 
strands. The unprotected copper in this inexpensive 
wire quickly oxidizes, especially when in contact with 
dissimilar metals on terminals. The low number of 
strands limits life in applications where flexing occurs. 
We recommend the use of high quality industrial grade 
wire with tinned copper strands and a high strand 
count.   

18-20 AWG sizes can be used for all signal and 
low current applications. 16-18 AWG is adequate for 
line lock and trans brake solenoid wiring. 14 AWG 
should be used for high current fuel and nitrous 
solenoid wiring. Carol UL grade 1007/1015 wire is 
available from Digi-Key. 

P/N   Description 

C2040X-100  20 AWG wire (100 foot spool) 

C2064X-100  18 AWG wire (100 foot spool) 

C2104X-100  16 AWG wire (100 foot spool) 

C2105X-100  14 AWG wire (100 foot spool) 

Note: replace X with color code B=Black, 
W=White, R=Red, G=Green, A=Orange, 
Y=Yellow, L=Blue, N=Brown, S=Gray,  
V=Violet 

CRIMP TERMINALS 

High quality crimp terminals and a proper 
crimping tool are required to make reliable electrical 
connections. Crimp terminals commonly sold in 
automotive and hardware stores have brittle vinyl 
insulation that easily cracks. We recommend the use of 
high quality industrial grade nylon insulated crimp 
terminals. The following parts are available from Digi-
Key.       

P/N  Description 

A27241  16-20 AWG #10 ring tongue terminal 

A27246  16-20 AWG 1/4” ring tongue terminal 

A27248  16-20 AWG 3/8” ring tongue terminal 

A27262  14-16 AWG 1/4” ring tongue terminal 

A27264  14-16 AWG 3/8” ring tongue terminal 

A27288  10-12 AWG 1/4” ring tongue terminal 

A27291  10-12 AWG 3/8” ring tongue terminal 

A0911  18-22 AWG .110” female quick  
  disconnect terminal 

MNU18-187DFIK 18-22 AWG .187” female quick 
   disconnect terminal 

MNU18-250DFIK 18-22 AWG 1/4” female quick 
   disconnect terminal 

MNU14-250DFIK 14-16 AWG 1/4” female quick 
   disconnect terminal 

A1069  16-22 AWG butt splice 

A1080  14-16 AWG butt splice 

A1086  10-12 AWG butt splice 

RELAYS 

The typical import brand 30-40 amp relays leave 
little safety margin. When used to switch heavy 
inductive solenoid loads, arcing can result in the 
contacts welding together – a potentially catastrophic 
failure mode. We recommend using Tyco/P&B 
automotive OE grade relays available from Newark 
Electronics and Digi-Key. Use the 40 amp version for 
most applications and the 70 amp version for 
fuel/nitrous solenoid activation. We recommend that 
you use the relay sockets and crimp terminals listed 
along with the relays.  

P/N  Description 

1432791-1 40 amp VF4 series relay 

VCF4-1001 Socket for VF4 series relay 

http://www.daytona-twintec.com/
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60249-1 12-16 AWG terminal for VF4 

VF7-41F11 70 amp VF7 series relay 

VCF7-1000 Socket for VF7 series relay 

42281-1 14-18 AWG terminal for VF4 coil
  connections (2 required) 

280756-4 10-14 AWG terminal for VF7 
  contact connections (2 required) 

FUSES AND FUSE TAPS 

ATC series fuses and fuse holders commonly 
used for automotive applications are only available in 
40 amp and lower ratings. For high current 
applications, we recommend the heavy duty 50 amp 
Littlefuse Maxi Fuse series available from Digi-Key.     

P/N  Description 

F1085  Maxi fuse block 

F1038  50 amp Maxi fuse 

 

SWITCHES 

All switches used in performance applications 
should be sealed. Representative sealed toggle and 
rocker style switches available from Digi-Key are listed 
below.     

P/N  Description 

480-2191 Honeywell SPDT toggle switch 

360-2278 NKK SPDT rocker switch 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RELIABLE CONNECTIONS TO EXISTING 
SIGNALS 

For some applications, you may have to tap into 
existing signal wires on the vehicle. We caution against 
using any of the so called “vampire clips” that make an 
insulation displacement connection. These have 
proven very unreliable in racing applications. They may 
even cause the original wire to fray and break. We 
suggest soldering any connections to existing signals. 
Use a stripping tool to cut through and push back 
about 1/4” of insulation at the spot on the original wire 
where you plan to make the connection. Wrap several 
turns of the new wire around, solder, insulate with self 
vulcanizing electrical tape, and use two cable ties to 
secure the splice as shown. Regular electrical tape will 
tend to unravel. Self vulcanizing electrical tape is 
available from Digi-Key as their P/N W213.    

 

SUPPLIERS 

Suppliers referenced in the Appendix are listed 
in the table below. Additional suppliers for connectors, 
electronic tools, mechanical hardware, and test 
equipment are listed on our website at     
www.daytona-sensors.com/tech_tools.htm. 

 

Supplier Phone Website 

Digi-Key 1-800-344-4539 www.digi-key.com 

Mouser 1-800-346-6873 www.mouser.com 

Newark 1-800-463-9275 www.newarkinone.com 

State Wire 
& Terminal 

1-800-922-6527 www.statewire.com 
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